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Workshop

Joint venture projects typically involve a number of contractors. Projects primarily executed in Smart 3D,
will receive models - process units, design packages, skid units etc. — produced by smaller contractors
designed in other systems having different model formats.

Ultimately, all models need to be brought together into a single view, to enable pipe routes to be
completed, ties to be made, hook-ups at interfaces to be verified, obstructions and clashes to be detected
and rectified, and to generate final isometrics and bills of materials.

Supporting this workflow, and ultimately providing a comprehensive model handover to the owner
operator, SmartPlant Interoperability, provided via SmartPlant Interop Publisher, enables Intergraph’s
own and 3™ party model formats to be brought together in Smart 3D. In this workshop, you'll step through
the entire process to see how easy it is to introduce a CADWorx model including its intelligence into an
existing Smart 3D environment.

The primary objective of this workshop is to show you that a CADWorx model can be transferred to Smart
3D with intelligence. Please note that it is not the intention of this workshop to teach you how to use or
model in Smart 3D.

During this session you will learn how
B A multi-discipline CADWorx model must be prepared for transfer to Smart 3D

B To process CADWorx design files through SmartPlant Interop Publisher to provide input for
SmartPlant Review and Smart 3D

To review the CADWorx model in SmartPlant Review

To use Project Management to
Attach a CADWorx model to Smart 3D
Apply a transformation (position, scale, rotate) to the CADWorx model

B Work with the CADWorx model in Smart 3D

Define the workspace view to display the CADWorx model as part of a larger Smart 3D model
Change the display of the CADWorx model’s surfaces/colors
Show and hide CADWorx model objects

View CADWorx model properties / attributes

Time permitting, you will also learn about the following in Smart 3D...
Creating and routing a pipeline
Interference checking

Generating piping isometrics
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Note. Should you run out of time but still wish to complete this workshop whilst at the
conference...providing no other workshop sessions are running in this room...you're welcome to come
back to this room to continue with any part of this workshop that you were unable to finish in the allotted
time. No one else will use your VM, so you will be able pick-up exactly where you stopped.

Getting started

Logging in to the VM

If the VM is not already logged in for you, choose Insert Ctrl-Alt-Del from the Machine menu that pops-
down when you move the mouse cursor to the top of the screen.

Press CTRL + ALT + DELETE to log on

S3DAdmin
and enter password - HXGN.2014

Note. Sometimes the Caps Lock control is reversed by Oracle Virtual Box. You may find this to be the
case on your system. If it is, caps will be on when the lock is off, and caps will be off when the lock is on.

You will be logged in and the first thing you will see is a command window. You need to wait for this to
close before continuing.

Let's get started!
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SmartPlant Interop Publisher: translating a CADWorx
model with intelligence

Note. You should spend no more than 10mins on this section.

You are going to translate this CADWorx (demo) model via SmartPlant Interop Publisher to create input
files needed for SmartPlant Review and Smart 3D.

Note. Only the design files are needed for this workshop, therefore CADWorx is not installed on the VM.

.~ HEXw2k3 ~ DATA (D:) - DATA - CADWorxdata = I_PRM_Model -~

Indude inlibrary =  Share with | Mew folder

MName = Date modified
J Civil 56,2014 4:27 &AM
J Equipment 5/6/2014 10:01 AM
| Piping 5/5/2014 9:57 AM

J Structure 5/6/2014 4:27 AM
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| .+ HEXw2k8 -~ DATA (D:) ~ DATA - CADWorxdata » I_PRM_Model - Piping

Indude in lbrary =  Share with =  Mew folder

ﬂ Name Date modified
|| 12-CU-4300-150-0.dwg 5/1/2014 3:27 AM
|| 12-CU-4100-150-0.dwg 5/1/2014 3:21 AM
|| 10-CU-4301-150-0.dwg 5/1/2014 3:21 AM
|| 8-CU-4102-150-0.dwg 5/1/2014 3:21 AM
|| 8-CU-4101-150-0.dwg 5/1/2014 3:22 AM
|| 6-0H-7100-150-TH2. dwg 5/1/2014 3:25 AM
|| 6-0H-7000-150-TH2. dwg 5/1/2014 3:25 AM
|| 4-0H-7102-150-H2.dwg 5/1/2014 3:25 AM
|| 4-0H-7101-150-TH2. dwg 5/1/2014 3:26 AM
|| 4-0OH-7002-150-IH2.dwag 5/1/2014 3:26 AM
|| 4-0H-7001-150-TH2. dwg 5/1/2014 3:26 AM

i ] 17401 1-43NN-1 500 Are S/R/IN14 T-NA AM

Model organization

As you would expect, it's important to ensure before handing over your CADWorx model to an EPC who
is using Smart 3D that all design files have the correct content, and the design files themselves are stored
in a folder structure that represents the plant breakdown structure. It will then be possible for the EPC
who takes delivery of your model to replicate and create the same breakdown structure under the
Reference 3D tab in Smart 3D.

Note. In the example that follows, although you start with the design files stored in discipline folders, this
structure is not maintained in Smart 3D.

Explore SmartPlant Interop Publisher

Double click

Intergraph
smartfl...

You'll notice that the main window is split into two sections, one containing the Source Files (inputs) and
one containing the Smart Models (outputs).

You will see that several of the files you will work with during this workshop are already processed and
listed in view below

May 30, 2014 6
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SMARTPLANT INTEROP PUBLISHER

Translate

© | Location T Source File Type

4-0H-7001-150-1H2.dwg DADATA\CADWorxdata\l PRM_Model\Piping} AutoCAD

4-OH-7002-150-H2.dwg DADATA\CADWorxdata\l PRM_Model\Pipingh AutoCAD
4—0H—?102—15{J—IH2.dwgl DADATA\CADWorxdata\l PRM_Model\Piping\ AutoCAD
E-OH-]"{]CKJ-}_‘?D—D-IZdwg! DADATA\CADWorxdata\L PRM_ModelPiping\ AutoCAD
6—0H—?10[J—150—IH2.dwgl D:\DATA\CADWDr:data\I_PRM_ModeT\Piping\é AutoCAD
8-CU-4101-150-0dwg | DADATA\CADWorxdata\l PRM_Model\Pipingh, AutoCAD

oR

 Name

Smart Models ]

HO2

EYC

3 4 -

| Location

I ' T?Pa 1 . Translation Status .i-Translatiun Date . SPF Publish S5t
4-OH-7001-150-1H2 nmATA\ﬁmnpdamen_Mbddmmm_smp\; vue  Complete 5/6/2014 9:48:46 AM  None
-rfl-OH-]I'i]ﬁ].?-]_‘i{}-l]-l2i D.‘\DATA\SP‘lOPdata\Smart_Models\CADWurx_SPIOF’\; vue i Complete | 5/6/2014 9:53:.01 AM l MNone
4-0H-7102-150-1H2 D:\DATA\SF’lOPdata\Smart_Mudels\CADWont_SF‘[OF’\; vue | Complete 5/6/2014 9:54:11 AM | None
ﬁ—OH—Tﬂm—ﬁﬂ—]]-IZE D.'\DATA\SP‘]OPdata\Smart_ModEls\CADWurx_SPIOP\; vue i Complete | 5/6/2014 9:54:47 AM l MNone

e e et A b b o e A R TR e s e o i ey, e

e R A

Note. Time is limited during this workshop so the files you are going to work with throughout are provided
in a partially complete state.

Project Settings

Take a

quick look at the Project Settings...

Click on

then select Project Settings from the pop-out menus

SMARTPLANT INTEROP PUBLISHER

Translate
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This dialogue appears

53D Train

Smart Model Location | D:A\DATA\SPIOPdata\Smart_Models\CADWore_SPIOP

&3

Project Schema | C:\Program Files\SmartPlantiInterop Publishe\SPRSchema.txt | Lz]

Label Schema | C:\Program Files\SmartPlant\Interop Publisher\SPRLabeISchema.| [I]

SmartPlant Review Site Name | Hexagon |

SmartPlant Review Site ID | HxGN |

Logging Options | Detailed Log v
Log File Location | CATemp | El

Mapping Files Location | C:\Program Files\SmartPlant\Interop F'ublisher‘BD{nterspMappir| :E]

Target Applications E SmartPlant Review
[] SmartPlant Foundation
[ Smart 3D

Graphic Options Keep lines and line strings

E] Turn on validation

Concurrent Translations | ak

The main options to note are

B Smart Model Location — this is where the translated data will be saved on disk

B Mapping Options — used to set either the default mapping configuration supplied out of the box,
or, to choose a custom mapping developed by the user

B Target Applications — used to specify what outputs are created, in this case only the files for
SmartPlant Review (MDB2, VUE) and Smart 3D (IOP, ZVF) will be output.

Click Cancel to close the dialogue and to return to the main window.

Translation Settings

Take a quick look at the Translation Settings

*° SMARTPLANT INTEROP PUBLISHER

Translate
Options > Configure Site Database
Help - s
Translation Settings
Exit Application ~ Change Theme

This dialogue appears

May 30, 2014 8
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S3D_Train

Select or Create Settings Group
s ~ ACIS Options
Alias ISOGEN ) |
AutoCAD |
CAESAR I
oy SubUnits | Meters =
IFC
16ES Sub Units per Master Units
MicroStation
POMS Positional Units per Sub Unit
PDS 3D
Smart 30 ~ Alias ISOGEN Options
XMpLant
Sub Units Millimeters v
Sub Units per Master Units
Positional Units per Sub Unit
~ AutoCAD Options
Master Units Inches b, 4

.

Select AutoCAD from the list and the window updates to show the current saved settings for AutoCAD
under the Default Settings Group

Aas ~ AutoCAD Options

Alias ISOGEN

(

T Master Units | Inches v

CAESAR 1T

asfz Sub Units | Tnches v

IFC

1GES Sub Units per Master Units

MicroStation

- Positional Units per Sub Unit

PDS 3D ; ”
7] Display proxy entities

Smart 3D Py prey

¥MpLant Publish reference models

Note. The CADWorx model is in imperial units (bores=inches and lengths=inches). This doesn’'t matter to
Smart 3D, in fact later, you will work in bores=inches and lengths=mm.

Click Cancel to return to the main window.

Note. You're probably wondering why there isn't an entry for CADWorx in the list. Well, CADWorx models
are AutoCAD design files, so only this option is required in the software. SmartPlant Interop Publisher can
automatically detect whether it is translating a native AutoCAD file, or an AutoCAD file containing
CADWorx objects and associated attribution. It will also automatically select and use the appropriate
mapping configuration from those supplied out of the box.

May 30, 2014 9
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| .| ~|Program Files = SmartFlant » Interop Publisher = 3DInteropMappingFiles ~ - lmj I Search 3DInteropMappingFiles

b d l;_T‘I Open -

Print  Mew folder

ﬂ Mame =~ Date modified Type | Size

J CustomMappingFiles 5/2/2014 3:23 AM File folder

| GenericMappingFiles 5/2/2014 3:23 AM File folder
@J AutoCADToR 3DMapping. xs 4/11/2014 5:22 AM Microsoft Excel 97-... 26 KB

ToR3DMapping. xls 4/11/2014 5:22 AM Microsoft Excel 97-...

@J CAESARIIToR 3DMapping. xls 4f11/2014 5:22 AM Microsoft Excel 97-... 28 KB
@J CISZToR 3DMapping. xls 4/11/2014 5:22 AM Microsoft Excel 97-... 30 KB
@J IFCToR 3DMapping. xls 4/11/2014 5:22 AM Microsoft Excel 97-... 142 KB
@J IsogenToR.30Mapping. xls 4f11/2014 5:22 AM Microsoft Excel 97-... 38 KB
@J MICROSTATIONToR 30Mapping. xls 4/11/2014 5:22 AM Microsoft Excel 97-... 106 KB
IEJF‘3DT0F~‘.3DI'\"IE||3|:|ing.:(Is 4/11/2014 5:22 AM Microsoft Excel 97-... 1,080 KB
@J PDMSToR.30DMapping. xls 4/11/2014 5:22 AM Microsoft Excel 97-... 1,020 KB
@JPDSLEgacyToR3DMapping.xIs 4/11/2014 5:22 AM Microsoft Excel 97-... 72KB
IEJF‘DSTDFs‘.3DI'\"IE||3|:|ing.:(Is 4/11/2014 5:22 AM Microsoft Excel 97-... 398 KB
IEJF‘Iant‘SpaceToFl30I'~"I.E||:|:ing.:t:ls 4/11/2014 5:22 AM Microsoft Excel 97-... 331KB
@J SPRDirectToR 30Mapping. xis 4/11/2014 5:22 AM Microsoft Excel 97-... 168 KB
@J %MPlantToR.3DMapping. xls 4/11/2014 5:22 AM Microsoft Excel 97-... 31KB

Note. Processing of data held in a CADWorx project database is not supported currently, only the design

files are processed.

The following files are not processed yet

Model discipline File

Piping 12-CU-4300-150-0.dwg
Civil F1.dwg

Equipment E101.dwg

Structure Sl.dwg

Location
D:\DATA\CADWorxdata\l_PRM_Model\Piping
D:\DATA\CADWorxdata\l_PRM_Model\Civil
D:\DATA\CADWorxdata\l_PRM_Model\Equipment

D:\DATA\CADWorxdata\l_PRM_Model\Structure

If you use the slider bars found on the right-side of both the Source Files and Smart Models windows,
you'll see that these files don't exist in either window currently

Smart Models ‘

Drag a column header and drop it here to group by that column
Name Location Type Translation §
R o st P ERERSRREE S R S
E-102 DADATANSPIOPdata\Smart_Models\CADWorx_SPIOP\  vue Complete
p-102 DADATA\SPIOPdata\Smart_Models\CADWorx_SPIOPY|  vue Complete
v-101 DADATANSPIOPdata\Smart_Models\CADWorc SPIOPY  vue Complete
v-102 DADATANSPIOPdata\Smart_Models\CADWorx_SPIOP\  vue Complete
V-103 DADATA\SPIOPdata\Smart_Models\CADWorx_SPIOPY  vue Complete

4-0H-7101-150-IH2| DADATA\SPIOPdata\Smart_Models\CADWone SPIOPY|  vue Complete
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Using the information in the table above, click on the + symbol above the Source Files window, browse to
each location in turn and select each missing file so that the Source Files window updates to show

Source Files |
& x&
Drag a column header and drop it here to group by that column
MName Location Source File Type
V-101.dwg DADATA\CADWorxdata\l_PRM_Model\Equipmenty, AutoCAD
B V-102.dwg DADATA\CADWorxdata\l_PRM_Model\Equipmenty| AutoCAD
B V-103.dwg DADATA\CADWorxdata\l_PRM_Model\Equipmenty, AutoCAD

4-0H-7101-150-IH2.dwg| DADATA\CADWorxdata\l PRM_Model\Piping', AutoCAD
12-CU-4300-150-0.dwg | DADATANCADWorxdata\l PRM_Maodel\Piping', AutoCAD

Fl.dwg DADATAVCADWorxdats\_PRM_Model\Civil, AutoCAD
E-101.dwg DADATANCADWorxdata\l_PRM_Model\Equipmentl, AutoCAD
Sl.dwg DADATAVCADWorxdata\l_PRM_Model\Structurel, | AutaCAD

Using the CTRL key + mouse left-hand mouse button (LHB), select these files by clicking on the grid next
to the Name column

Source Files |

R

Drag a column header and drop it here to group by that column

Name Location Source File Type
V-101.dwg DADATAVCADWorxdata\l PRM_Model\Equipment = AutoCAD

| V-102.dwg DADATAVCADWorxdata\l_ PRM_Model\Equipment | AutoCAD

| V-103.dwg DADATAVCADWorxdata\l PRM_Model\Equipment = AutoCAD

| 4-0H-7101-150-IH2.dwg  DADATANCADWorxdata\l_PRM_Model\Piping\ AutaCAD

P | 12-CU-4300-150-0.dwg  DADATA\CADWorxdata\l_PRM_Model\Piping\ AutoCAD

Fl.dwg DADATAVCADWorxdata\l_PRM_MedelCivily AutoCAD
E-101.dwg DADATAVCAD' _PRM_Model\Equij t AutoCAD
Sldwg ‘ DADATANCADWorxdata\l_PRM_Model\Structure\  AutoCAD

Now click the Translate button (right-most icon) on the toolbar

Source Files

o R

This dialogue appears

Smart Model Location | D:ADATASPIOPdata\Smart_ Models\CADWon: SPIOP | =

Mapping Files Location | C:Pragrem Files\Smariflantiinterap Publisher\3DinterophappingFi

[ 1 Reduce VUE file geometry memary

Translate

Accept the defaults and click Translate.

Translation begins and the Smart Models window updates to show

May 30, 2014 11
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Smarandels‘
ERBO2E A -

Drag a column header and drop it here to group by that column

Name Location Type Translation Status.
B e Y G PTG P T ST PTG P TS o E——

Vv-102 DADATA\SPIOPdata\Smart_Models\CADWorx SPIOP\  wvue Complete

4-0H-7101-150-IH2| DADATANSPIOPdata\Smart_Models\CADWorx_SPIOP\  wvue Complete

12-CU-4300-150-0 = DADATA\SPIOPdata\Smart_Models\CADWore SPIOP,  wue In Progress.

F1 D:ADATA\SPIOPdatal\Smart_Models\CADWorx_SPIOP,  wvue Mone
E-101 DADATANSPIOPdata\Smart_Models\CADWorx_SPIOP\.  wue None
s1 D:ADATA\SPIOPdatal\Smart_Models\CADWorx _SPIOP\  vue None

Whilst the files are translating...read and do the following...
But just what does the translation process produce?

Use the Windows key + E to open Windows Explorer, and then browse to

M capworx_sPIoP

%v | |~ DATA(D:) ~ DATA ~ SPIOPdata ~ Smart_Models ~ CADWorx_SPIOP ~
Organize v  Indudeinlibrary +  Share with +  New folder
= Libraries 2l Name -
@ Documents
ds Music L vLUE
[&=] Pictures L Z¥F

The VUE folder contains the files required to visualize the model in SmartPlant Review

%v | |~ DATA (D:) ~ DATA - SPIOPdata = Smart_Models = CADWorx_SPIOP = VUE

Organize * Indudeinlibrary =  Sharewith +  New folder

.- Libraries =] Name -
@ Documents
4-OH-7001-150-TH2.CFG
J’ Music —

] Pictures || 40H-7001-150-H2.log
B videos (& 4-0H-7001-150-1H2.mdb
B s3DAdmin || 40H-7001-150-1H2. mdb2
188 HEXw 28 4-OH-7001-150-THZ.vue

& LocalDisk (€ | ] 4-0H-7002-150-1H2.CFG
(=5 DATA (D)

|| 4-0H-7002-150-IH2.log

. app
DATA () 4-0H-7002-150-1H2. mdb
ki
|| CADWorxdata || 4-0H-7002-150-TH2.mdb2
|| 53Dbackups 4-0H-7002-150-1H2. vue

The ZVF folder contains the files required to reference the CADWorx model in Smart 3D

May 30, 2014 12
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eq J< | .~ DATA(D:) ~ DATA - SPIOPdata » Smart_Models ~ CADWaorx_SPIOP ~ ZVF

Organize ¥  Indudeinlibrary =  Sharewith +  New folder

@ Documents LI Name “
J’ Music
] Pictures | | 4-0H-7001-150-IH2.iop
BE videos || 4-0H-7001-150-1H2.log
A 53DAdmin (2] 4-0H-7001-150-1H2.mdb
=118 HExw2ka || 4-0H-7001-150-1H2.mdb2
&, Local Disk (C:) | | 4-0H-7001-150-1H2. %rg
Bl DATA ) 4-0H-7001-150-1H2.2vF
. app
5 B pata | ] 4-oH-7002-1501Hz2.i0p
N
|| CADWorxdata || 4-0H-7002-150-H2.log
|| S3Dbackups 2] 4-0H-7002-150-TH2.mdb
|| 53Ddata | | 4-0H-7002-150-1H2. mdb2
. 53Dsymbols | ] 4-oH-7002-1501H2.%rg
= |/ SPICPdata

8| 4-0H-7002-150-TH2, zvwf

Note. MicroStation is not present on this VM therefore the files you are currently translating cannot be
used for the subsequent stages of this workshop. Refer to Appendix | later for further information about
this pre-requisite.

From this point on you will use pre-processed files that were prepared earlier, using MicroStation. These
files are located in this folder

eq ||v| |~ HEXw2k8 ~ DATA (D:) ~ DATA - SPIOPdata ~ Smart_Models ~ SPIOP_S3D ~

Organize *  Indudeinlibrary =  Share with +  New folder

‘J'! Music _I‘ Name «
| Fictures

| VUE
B videos

1 53DAdmin ks ZVF

Translation should now be complete

SmarlMDdels‘
FRLOAE A -

Drag a column header and drop it here to group by that column

Name Location Type Translation Status

o= S e e

v-102 DADATA\SPIOPdata\Smart_Models\CADWorx SPIOP,  vue Complete

4-0H-7101-150-IH2| DADATANSPIOPdata\Smart_Models\CADWorx_SPIOPY  wue Complete

12-CU-4300-150-0 | DADATA\SPIOPdata\Smart_Models\CADWon« SPIOP\  wue Complete

F1 DADATA\SPIOPdata\Smart_Models\CADWond _SPIOPY  wue Complete
E-101 DADATANSPIOPdata\Smart_Models\CADWorx_SPIOP,  wvue Complete
51 DADATANSPIOPdata\Smart_Models\CADWorx_SPIOPY  vue Complete

Exit the application.
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Visualize a CADWorx model in SmartPlant Review

Note. You should spend no more than 5mins on this section.

Start SmartPlant Review

SmartPlant
Review

Choose File > Open and browse to D:\DATA\SPIOPdata\Smart_Models\SPIOP_S3D\VUE.

Select all of the files with a .vue extension then click Open

5
|°\ )v|  + SPIOPdata + Smart_Models = SPIOP_S3D = VUE ~ 23 [ search viE !_c]‘
Organize *  New folder 4=~ [l I@I

w DATA (D2} ;I Mame ~ Date modified ;I
| app -

DATA [ s-cu-4102-150-0.vue
| CADWorxdata B 10-cu-4301-150+
| 53Dbackups
| 53Ddata B 1zcu=
| 53Dsymbols m E-10
i SPICPdata B e-102.vue

| CWX-TPRM

Fl.vue
. Mapping B vue
. R3D_Models

. Smart_Models
. CADWorx_SPIOP
. SPIOP_S3D
. VUE

.ZUF. LI‘

FiIename:I"V—103.vue" "4-OH-7001-150-H2.vue" "4-OH- | |SmartPlant Review VUE (".vue) |

Open I Cancel |

4

(2014 3:59 AM

Enter CWSPR as the name of the SVF Project then click Save
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& save SVF Project As x|
3

OO | . = SPIOPdata = Smart_Models » SPIOP_S3D - VUE - MI search VIUE

o

Crganize *  Mew folder 4= - @

. DATA ﬂ Name = | Date modified

. CADWorxdata
| 53Dbadwups No items match your search,
. 53Ddata
. 53Dsymbals
, SPIOPdata

. CWX-IPRM

. Mapping

J R3D_Models

J Smart_Models

. CADWorx_SPIOP

. SPIOP_S3D
. VUE
| ZVF x| 4] i
File name: | CWSPR| =
Save as type: ISUF Files (*.svf) j

“  Hide Foldersl Save I Cancel |

Accept the default settings on this dialogue and click OK to continue

Create Project ll

Database |O|:|t'ons | smartPlant 30 |

Mame:
[10Pdata\Smart Models\SPIOP_S30\WUE\CWSPR.mdb
r— Configuration
Project schema:
I C:'\Program Files (x86)\SmartPlant\Review\5PRS Browse... |
Label schema:
I C:'\Program Files (x86)\SmartPlant\Review\SPRL: Browse... |
Site name: Site ID:
| Huntsville |Hsv1
I” Single latel database

OK | Cancel |

And do the same for the next dialogue too - just click OK to continue

M Load Vue Files x|

May 30, 2014 15
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The CADWorx model will appear

& SmartPlant Review - [CWSPR.svf]

Note. If it doesn’t appear, you may need to open a new window.

Using these controls

And these

May 30, 2014 16



Visualize a CADWorx model in SmartPlant Review

EEBEEDRDE Qa

manipulate and navigate the model so that equipment E-101 is displayed as shown

|
For Help, e F1

frown] & 8 Lal@l

-
T zomm

Querying model properties / attributes

Click on this nozzle with the LHB to select it, then right click and select Properties from the pop-up menu

Select Filter Elements
* Select Filter Objects

Select Filter Linked Objects

Select Filter Display Sets

Hide Objects

Find Object Cirl+F
Axis

Activate Clipping Volume

View Settings... F&
Motion Settings... Cirl+F7
Detect Collisions Ctrl+F12
Mew Display Set...

Delete Display Set

Undo View Change Ctrl+Z
Fedo View Change el

Get External Data
Prop

May 30, 2014
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H

S

Propedy Value

~ Object 1 |
Aspect Sample Physical
Linkages ooDe
Chsplay Set 0 Ungrouped Blements

B Label Data (SMART_SOLID_ELEMENT)
DG Blement Type SMART_SOLID_ELEMENT
LayerlD Equip
Class Primary
Model Name Madal
lIDFor TypaString 2836
SystemPath //Madel
Graphic Group [
Mn. Geom Bdents (Fest) (4. 749672, -14 491470, 6615157)
Max. Geom Exdents (Fest) (5.250000. -13.991142, 7.354003)
App Nama CADWORX _EQUIPMENT
Object Type: Nozze
NominalDiameter 2.000000
Name E101
D N4 g
Pressune Rating 150

' 3DintempllxssiD CRADPpehozte ll

Looking at the same nozzle in CADWorx...

Equipment Name:
|E101 -

[ Placemenl Components -

B Nozzle [N4] -

Description M4

Mozzle type Standard

Distance 7'-10"

Standard Nozzle Details 2" -150 - RFWN

FVC Nozzle Details

Layout angle 0.00

OQutside projection g1/2" E
Inside projection 0"

You will make a connection to this nozzle in Smart 3D later.

Select File > Exit to close SmartPlant Review.

May 30, 2014 18
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Attaching a CADWorx model to Smart 3D using
Project Management

Note. You should spend no more than 10mins on this section.

Start Project Management

4# Database Wizard

F: Project Managemen

| dal Cemmrt TN .

Please be patient whilst the software loads and configures itself.

Expand the tree to show

4] Project Management : HEOW2K8\HEXMSSQL : SP3DTrain_SDB : HE
Database Edit View Go Tools SmartPlant Help

&= 2lels] *[=@] &l 5]

Address IEQ SmartPlart 30" Flants\SP 30 Train"\Reference 30 Models

E SmartPlant3D

@, Locations

-3 Reference Data

. m. SP3DTrain_CDB

EI* Plarts
- ol SP3DTrain

(5] Drawings

i Interference Checking

| Modeling

ﬁ Interference Server

[ —'Y Reference 3D Models
[—— SP30Train_U01

Right click on Reference 3D Models and choose New Reference 3D Model from the pop-up menu

[devy Permission Group Folder, .,
ey Permission GEroug, ..

Iiews P Madel Reference. ..
[dews Point Cloud Model Reference. ..

MNew Reference 3D Model...
Update Reference 3D Model(s)...
Project Settings 3

Attach CADWorx (reference 3D) model

Clicking in each field one by one, make the settings shown below then click OK

May 30, 2014 19
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New Reference 3D Model x|

Property Walue
Model Name CW_s3D
Description CADWoncto 53D
Model Type SmartPlant Interop Publisher
Intefference Detection Participate
File Path DADATANSPIOPdatatSmart_Models'\SPIOP_S3D
— Reference Poirt
Easting: Morthing: Elevation: Unitg;
D.00m p.00m 0.00m m =l
r Trar 1
r Rotation
East Angle (deg): North Angle (deg): Up Angle {deg):
|u.on deg |u.on deg |D.DD deg
Scale Factor:
1
r— Target Point
Easting: Morthing: Elevation: Units:
[0.00m [o00m 0.00m m =l

i Project Management : HEXW2KB\HEXMSSQL : SP3DTrain_ SDB : HEX
Database Edit Wiew Go  Tools  SmartPlant  Help

€| =23 Eels] X&) e o

Add :IE Mew Reference 3D Model ¥ I

Attaching New Reference 30 Model...

I UIEE

+ Detecting Reference 30 Schema
" Installing Schema
+"  Lpdating Business Object Classification
#  Unpacking Streaming VUE Files
Loading Reference 3D Data into Model Database

. HE Irtafarnnna Carvar

Please be patient...it will take approximately 15-20 secs for the information to be added to the database.

EIR HP NASHISISHILS ST VS
o & Reference 30 Models
.............. & Cw_S3D

.............. % SP30Train_UM

Minimize the Project Management window so that it remains open and accessible via the Task bar.

Start Smart 3D
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Intergraph
Smart 3D

Click cancel to close this dialogue

General |

EnglishUrits  MetricU nits

Ok, I Cancel I

Select S3D_Train_A2_Reference_3D.ses from the most recently used entries on the File menu

PN [Untitled]
File

Mew. .. Ctrl -+
Cpen... Ctrl+0
Clase

D:\DATANS3Ddata\s30 _Train_A2_Reference_3D0.s

D:\DATANS3Ddata\s30_Train_All_Review.ses
D:\DATAVS3Ddata\untited ses

Exit Alt+F4
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PN53D_Train_A2_Reference_3D.ses : Common : SP3DTrain : 53D_Train_A2_Reference_3D - [GraphicView:1 - Looking NE (45° from N ) and 35° Down]

o S = DIS(EIE| EBlE] el ol 2Ehdle] SB(0enEiE] QlzmaEE 2
=

The CADWorx model is not shown yet; to display it, you must update the WorkSpace view to include the
smart (Reference 3D) model ‘CW_S3D’

Select

" Y53D_Train_A2_ Reference_3D.ses:Common : SP3DTrain : 53

Select Properties

Define Workspace

530_Train_AZ_Reference_30 |

May 30, 2014 22
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Filter Properties x|

Mame:
|53D_Train_A2_Reference_3D

Propertiesl Reference | v Reference 3D| Configuration
Work Breakdown Structurel Permission Group I Object Type | Volume |
v System | P«ssemblyl Named Space I Analysis I

Expand the search to include the selected systems:

SPA0Train
Al

Select the | Coceeisis I tab and make sure the entire tree is selected as shown (click at the top part
of the tree to do this)

Filter Properties

MName:
|53D_Train_A2_Reference_3D

Work Breakdown Structurel Permission Group I Object Type | ‘u’olumel
¥ System | Assembly |
F‘ropertiesl Reference | _

Click OK to close this dialogue and OK again to execute the database query.
Be patient whilst Smart 3D refreshes the view.

Initially, you will see little change in the model displayed?

Select @ then click Plan

| Looking Flan |

Select L2 and zoom in to the area highlighted below by the green dashed box
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T30 Tram A3 Relerence 30.ues : Commeon ; P30T raim : $10_Train_A3_Relerence_I0 - [Graphicvies: - Looking Duwn] Ik
Wk Fle Edt Vew beet Fomat Tos Prowct Smant Taks Wides Hep Al

o = = Di@l@R] Blelx] w5 wl sl @l znleE- ol minEic 1

s =l
&)

Drst]| 3 B o S ] T W v omE

Notice the very small CADWorx model positioned at EO, NO, UO (the bottom-left vertical column of the
pipe rack is actually at this co-ordinate).

A transformation needs to be applied to move the model and to scale it in line with the design units.

Find Project Management on the taskbar
1

‘ Project Management : HEXW 2K8YHEXMSSQL : SP30Train_SDB : HEX |>
f__'startl hH B 5 . || -

Click on the icon to maximize the window
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Right click on the CW_S3D entry under Reference 3D Models in the tree and select Properties

. d Reference 3D Models |

[dew Permission Group Falder. .

[ew Petrission Group. ..

Idew PO Made| Reference. .,

Iev Paint Cloud Model Reference, ..
Iew Reference 300 Madel .,

Update Reference 20 Madel(s).. .
Project Settings 3

Copy,
Paste

Delete
Regenerate Reports Database. .
Rename, .,

PEIMISSIans,

Duplicate Plant for Workshare, . .
Consolidate Blant from Warkshare,

Configure Queues Far Jobs

Change the properties to show

ﬂ
General |
Category:
IStandard j
Property Value
Model Mame CW_53D
Description CADWorcto 530
Model Type SmartPlant Interop Publisher
Interference Detection Participate
File Path DADATANSPIOPdatatSmart_Models\SPIOP_S3D
- Reference Poirt
Easting Morthing Elevation: Units:
[o00m 0.00m 0.00m m =l
— Trar
Rotation
Ezst Angle (deq): MNorth Angle (dea): Up Angle (deg):
|ﬂ.ﬂ4} deg |u.m deg |9D.DD deg
Scale Factor:
| |12
Target Prirt
Castng Northing Eevarw. - Units:
" [11.00m [22.00m [150m Jm =l
(=
[¥ Reference 3D Model data has been updated files added, removed or modified)
I~ Force Update all Reference Filesfincluding those not modified)

oK I Cancel | Apply

Click Apply followed by OK to close the dialogue.

Note. The session file is set-up to use Imperial bores and Metric co-ords and lengths whereas the master
and sub-units of the CADWorx model are in Inches. To resize the model therefore, a scale factor of 12
must be applied.

Return to Smart 3D.
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Click to refresh the workspace view.

Click @I to fit the model.

:%i0_Aram_ AF Aelerrsse 30 - [Grophaieel - Loolong D]
nt Tels Weisw  Mep

o] #la] o SEdudle] &

®-
=
.
AN n1 o
|
PR b

The CADWorx model is now the correct size but is still displayed in the wrong orientation.

Switch back to Project Management and set Up Angle to be 0.00 deg, and then click Apply and OK

Up Angle (deg):
|0.00 deg

Close Project Management using Database>Exit.

Return to Smart 3D.
Click to refresh the workspace view.

Click @I to fit the model.

Click @ then zoom in to the area where the CADWorx model is displayed by striping a window as
shown
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Working with a CADWorx model in Smart 3D

Note. You will spend the remaining 20mins on this section.

Navigation and model view manipulation

Defining the workspace

To make it easier to work with S3D, first, modify the
only unit U0O3 and the CADWorx model are shown.

If zoomed in, click @l to fit the model.

Select File > Define Workspace or press CTRL+W.

Filter:
ISSD_Tlain_ﬁZ_Heference_SD j Properties |
Bole:
I None j
oK I Cancel

filter that controls how the model is displayed so that

Click on Properties.

Click on % the next to A2 to expand the tree

Filter Properties

MName:
|S3D_Train_A2_Reference_3D

F‘ropertiesl Heferencel v
Work Breakdown Structurel Pe
v System | Assembly | Named ¢

Expand the search to include the s
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Click on U03, this will deselect everything else in the list

1 SP3D Train
41

gl A3
B[] Areall
B CS

Switch to the Reference 3D tab

ce | v Reference 3D| Con

i |n=!| Pemiszicn (aronin I iy

Click on

Reference 30 Models
®RECW 53D

(@ SP3DTrain_UDT

Click OK to update the filter and close this dialogue.
Click OK again to close the Define Workspace dialogue.
Please be patient whilst the query is executed.

The workspace view updates to show

Note. Any number of filters can be set-up meaning different views can be quickly switched between.

Click |E| to save changes to the session file.
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Click |@I to display the Common Views dialogue

Common Views -]
Ne Y O LY

Quickly experiment with the common views cube and the tools below before continuing.

@I - Fit View
@ - Zoom window

@-Pan

Note. A right mouse button click anywhere in the main window terminates any of these modes.

Note. This section is optional, skip it if you wish (go to section Showing and hiding CADWorx model
elements).

You'll notice that the CADWorx model is displayed in different colors to those used for the S3D model.
Surface Style Rules control how referenced models are displayed.

Select

ce_3D.ses : Common : SP3I

|Furmat Tools  Project  Smi

| View...

Surface Style Rules...

Using the slider bar to find them first then Shift + LHB, select the entries shown then click Add to move
them to the right-side of the dialogue, then click OK to apply the change and to close the dialogue
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surface Style Rules x|
Style rule library: Selected rules:

4512 Mat-Coni Add ->
3110

<- Eemove |

Move Up |

Move Down |
Mew...

Fodify |

Copy |

Paste |

;I Delete |

’TI Cancel | Apply |

g 130 Sup
9110_5_Member
5111_5_Memb_Column

The model will refresh and now the CADWorx model is displayed as if it were originally created in S3D

Click |E| to save changes to the session file.

Make the Reference 3D tab on the Workspace Explorer active by clicking on it

System | Assembly | Space | WBS [

[=_p Reference 30 Models
[(@CwW_53D

Expand the tree as shown
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Workspace Explorer

3TTW o i
! |

rence 30 Models

CW_S3D

(@ zvF

£ 10-CU-4301-150-0.2vf
— P 12-CU-4100-150-0.2vF
—p 12-CU-4300-150-0.2vF
£ 4OH-7001-150-H2 2vf
—{p 40H-7002-150-IH2 2vf
L 4OH-T101-150-H2 2vf
—(p 40H-T102-150-1H2 2vf
— £ 6OH-7000-150-IH2 2vf
—(p 6OH-T100-150-1H2 2vf
— L BCU-4101-150-0 2vf
L 8CU-4102-150-0.2v
L E-101 2

—E# E-1022

— L Flavf

3 P-102.2

L 51

— P V1012

— £ V10220

L V1032

System | Assembly | Space | WES  Reference 3D

Right click on each entry in turn in the list to hide F1.zvf, S1.zvf and V-101zvf so that the workspace view
updates to show

E
hkf" [=—_p Reference 30 Models
CW_53D
[ zvr
£ 10-CU-4301-150-0.2v
€ 12-CU-4100-150-0.2vF
£ 12-CU-4300-150-0.2vF
£ 4-0H-T00-150-H2 2vF
£ 4-0H-7002-150HH2 2vf
£ 4-OH-T101-150-H2.2vF
€ 4-OH-7102-150-H2 2vf
£ B-OH-T000-150-H2 2vF
£ B-OH-T100-150-H2 2vf
g 8CU-4101-150-0.2vF
£ 8.CU-4102-150-0.2
£ E-101 2w
£ E-102.20
L Flav
£ P-102.2v
G 572
—E 110720
P V-102.2
L V1032

“‘:i 5---__-_-_ 5
_ <
A
‘l’

A

" System | Assembly | Space | WBS  Reference 30

Using the Show option on the same pop-up menu, show everything again so that the model view returns
to what it was previously.

Click on the System tab on the Workspace Explorer to make it active
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System | A

Zoom in so that the view is as shown

o
@ P Edt View Imet Fomat Tosh Peoject Searfant Tada Widow Heb

| | I— 1 = 1Tt e P = T P s e = S e e R

T

o

Tip: The Zoom tool gl is useful to make minor adjusts to the zoom. Click and hold down the LHB whilst
moving the mouse diagonally-left or diagonally-right to either zoom the view in or out.

Click on the Select command il icon to ensure these settings are active

.'._SSD_Train_AZ_REferenc

@ Fle Edit View Insert
I:’-‘-J:Imin j I
BT
Al

&

Click on this nozzle on equipment E101

Right click and select Properties from the pop-up menu
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Select Nested

Copy
Paste

Delete

Show
Hide

Claim

(&0 bo Hyperlink
Froperties

X g

General | configuraton | {General’| configuration |

Category: Category:
Standard 'I Standard VI
Property s 'SLI Property Va\ue;l
Nominal Diameter 2000000 Outer Diameter
Layer Eauip Source object typs CRIDPipehozzle
Level 7 Class Primary
Source Identffier DGN Element Type SMART_SOLID_ELEMENT
o] Na— J Graphic Group 0
Temination Max. Geom Edents (Feet) (5.250000, -13.991142, 7.354003)
End Preperation Min. Geom Bxterts (Feet) (4.749672, -14.491470, 6.615157)
Pressure Rating 150 Model Name Model
Pressure Rating Standard SystemPath /~/Model
End Standard App Name CADWORX_EQUIPMENT
Flow Direction Object Type Mozze
T =] L

ok | concd | e | ok | cancl | ey |

Comparing with the same nozzle in CADWorx and SmartPlant Review seen earlier...

quipment Hame &
€ N ; sl @
. Propery Value
-.Eim et ] - Object n Al
Fapect Simple Physical
Linkages 00016
Placsment  Components Display Set 0 Ingrouped Blement
! . B Label Data (SMART_SOLID_ELEMENT)
B Mozzle [Nd] = DGN Blement Type SMART_SOLID_ELEMENT
LayerdD Equip
o L e
Description N4 = Fi
Mozzle type Standard T %
Distance 710" e G -
= Min. Geom Exents (Feet) {4.749672, -14 491470, 6.615157)
Standard Nozzle Details 27 - 150 - RFWN Max. Geom Extents (Feet) (5.250000. -13.991142, 7.354003)
FVC MNozzle Details #op Name CADWORX_EQUIPMENT
Object Type Noxzde
Layout angle 0.00 Bty 25
i - E ] N4 i
Outside projection 8172 L N— it
Inside projection 0" B CRIDPpeNozze o

Time permitting use the same technique to query the properties of other CADWorx model objects.
Hitt
The main objective of this workshop was to show you that a CADWorx model can be transferred to Smart

3D with intelligence, so if you've reached this point by the end of the 45mins, you've achieved what you
needed to!

Everything else that follows is considered to be optional and advanced. If you have time, please continue,
otherwise, don't forget, this document is yours to take away!
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Routing a Smart 3D pipe from an intelligent CADWorx nozzle

As well as being a database solution, Smart 3D is also a task-based solution. So far you have been
working with the Common task, now you will work with the Piping task.

Activate Interference Checking

In Smart 3D, interface checking is a process that runs silently in the background, always looking for clash
situations.

s 1 Common : SP3DTrain : 5
Tools Project SmartPlant T
Select by Filter...
Shiaw
Hide:
Show All

. PFinPaoint
SmartSketch Options
Add to SmartSketch List
Get Point
Point Along
Measure

Chedk Interference

Note. The toolbar area automatically re-configures itself to show additional icons, selection boxes etc.

Click the Properties

.. Interference Checking Settings x|

Display | Datebsse Detect  Looal Detect | Status

I~ @ctivate local interference defection:
Assign interference checking prionty to aspects:

== Type
Smple physical Required -
Detailed physical checke:
Insulation checke:
Operation checke:
Waintenance checke:
Reference Geometry
Certedine checke:
Wolded Forms checke:
Foyiinment Hole: checkes -
] ,
Compar Include dlearance e
¥ Bequred - Requred No Clearance Rule -
[ Reguired - Optional

Marker size

¥ Optional - Optional IZSDDDmm—
I~ 5F30- Fairt Cloud

0K | Concel | ety

Check this box then click Apply followed by OK.

v Activate local interfference detection:
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Note. In a large project, particularly if Smart 3D is integrated with SmartPlant P&ID, the pipelines that
need to be modelled would already be present in piping hierarchy, under the relevant Area\Unit.

Next, you will create the required piping hierarchy to create a new pipeline on-the-fly.

First, click on the Select command il icon to ensure these settings are still active

'-_SSD_Tra in_A2_Referenc

@\ Fle Edit View Insert
IAdmin j I
[

All

D

Next, expand or collapse the Workspace explorer tree so that it looks like shown

Workspace Explorer

ISPSDTlain

SRBT]SP 30 Train

:j] Supports
m Water

g E“ﬁSPSDTﬁin
7
Mew Generic System M
MNew Area System ————
Mew Conduit System Select Nested [
Mew Electrical System Copy
Mew Equipment System Padts
Mew HVAC System Delete
Mew Pipeline :
New Piping System Go to H)rperlmk
New Structure System Properties
Mew Unit System

Type the name shown below in to the dialogue then click OK
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Property Pages Dialog 5[

Piping System |
Category:
Standard j
Property Value
MName CADWor_Pipelined
Name Rule User Defined

The Workspace Explorer updates to show

Workspace Explorer

|una

E-Lg SP30Train
A2
ERFEY 03

A CADWond_Fipelines

E-Lp SP3DTrain
A2
uo3
| pesn RTINS

Mew Generic System m
MNew Area System
Mew Conduit System i
MNew Electrical System Copy
MNew Equipment System feste
MNew HVAC System Delete
MNew Pipeline )
Mew Piping System e Hmrllnk
Mew Structure System FRESIEE
Mew Unit System

Type the name shown then click OK

Property Pages Dialog x|

Fipeline |
Category:
IStandard j
Property Value
Name 2<0H-5001-150-IH2
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Waorkspace Bxplorer

[2-0H-5001-150-H2 =1

E-_p] SP30Train

T
=48 U03

] CADWore_Pipelines
Yo OH-5001-150-H2

Ll Mo casol

Notice that toolbar area also changed

m53D_Train_AZ_REference_SD.ses : Common : SP3DTrain : 53D _Train_A2_Reference_.
‘ File Edit Wiew Insert Format Tools Project SmartPlant Tasks Window Help

| drin = & D||ER] B|eX] #/s] o &
&) | Sl e
MName: System:

IZ—O H-5001-150-1H2 ICADWDrx_F‘ipelines j

| dh N

Now, using the navigation techniques learnt earlier, zoom in and adjust the window display so that you
have this view

Select the Piping task from the drop-down
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53D_Train_A2_Reference_3D -
Tasks Window Help

Catalog

Civil

Compartmentation
Drawings and Reparts
Electrical

Equipment and Furnishings
Grids

Hangers and Supports
Hole Management

HVAC

Layout

Materials Handling
Molded Forms

Fiping

Planning

Space Management
Structural Analysis
Structural Detailing
Structural Manufacturing
Structure

Systems and Specifications

Configure Task List...

Smart 3D reacts and re-configures the user interface.

Click the Pipe Routing @ icon from the toolbar at the left-hand side of the screen

Move the mouse cursor over nozzle N4, and when you see the fly text update to what's shown below,
click once with the LHB

Please be patient at this point as at first it may seem that nothing is happening, but this dialogue will
appear eventually
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x
| reference 30 |

Category:

IStandard | Ellllfl nl
Property Value
Pipeline
Name
Name Rule DefaultNameRule
Specification
Nominal Diameter 2in
Flow Direction UNDEFINED
Fipe Run Type Undefined
Minimum Slope MNet Sloped
Schedule Overide -1
Comelation Status Mot comelated
Comelation Basis Correlate object
Comelation Approval Status

o4 Cancel

Click on the Pipeline field and select More ...

kg

General |Rgference 3D |

Category:

IStandard j @||ET| nl
Property
Fipeline

hlmmma

Select the pipeline shown then click OK

Select System x|

Look In: " Workspace " Database

- SP30Train

A2

=Hae 103
'-‘! CADWore_Pipelines
el 0H-5001-150-HZ
E_IEquipment

Click on the Reference 3D tab
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Mew Pipe Run 5[

"General Reference 3D |

Property Value
Part 1D N4
Nominal Size 2
MNpd Unit Type in

Termination Class

Temination Sub Class

End Preparation
End Practice
End Standard
Rating Practice United States of America, Standards
Pressure Rating CL15D
Schedule Practice

Schedule Thickness
 ——

Click on the Reference 3D tab, set the following exactly as shown, then click OK to close the dialogue

x|
"General Reference 3D |
Property Value
Part 1D Eﬂ_
Nominal Size 2
Npd Unit Type in
Temination Class Bolted
Temination Sub Class Fanged
End Preparation Raisedface flanged end
End Practice United States of America, Standards
End Standard Default
Rating Practice United States of America, Standards
Pressure Rating CL15D
Schedule Practice United States of America, Standards
Schedule Thickness S-5TD, Standard Weight

Please be patient whilst Smart 3D updates the database.

You will probably see this dialogue pop-up...just press OK to accept it...

smartPlant 3D x|

Ma Termperature and pressure data has been defined far the pipe run being modeled. Az a result, compliance with
the temperature/pressure service limitz as defined in the piping specification cannot be confimed. Do you wish to
cohtinue modeling the pipe run anypway?

[~ do mot show thiz message again.

Cancel
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The view should update to show the pipe dynamically connected by a flange to the nozzle

S3D_Train_A2_Reference_3D.ses : Piping : SP3DTrain : S3D_Train_A2_Reference_3D - [GraphicView:1 - Looking NE (45° from N ) and 35° Down]

@\ Fie Edit View Insert Format Tools Project SmartPlant Tasks Window Help

A = anul BlRaX| 2z o] 2 "él)é&) &8s |2 nEiE-] al+

Angle Tum option Straight option: Offset:

Plar ne
= e = R |un}2 Undefined 00011 =] g [0.00deg =] [aefaut J_|455 EEmm =] [zt ] [<Disabled> =]

The pipe and flange are not fully placed just yet, so don't click anything or anywhere in the window!

Note. If you make a mistake and need to start again, use the Undo El command to roll back what
you've done so far, up to the point where the Pipe Run is deleted.

You'll notice when you place the mouse cursor close to the vertical axis that these glyphs appear next to
the end of the pipe

These are SmartSketch settings, they work in a “similar” way as snaps do in AutoCAD, and are used to
control routing behavior and help guide the user to make accurate routes in any of the orthogonal
planes/axes — N/E/Plan etc.

Enter the length shown and press Enter in the field

| 2] s 'i«:ﬁll}&’ﬂlé’?l @I”ﬂlﬂlnh‘i’*

um option: Straight optic

lefault I I I Iu:lefauft

Then, ensuring the glyphs as shown above are displayed next to the end of the pipe, click once in the
view.

The vertical pipe and attached flange are placed
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Note. If the Reference3D Object Type had not been recognized by Smart 3D as a true Nozzle, it would
not be possible to make an intelligent piping connection. If the component had simply been a generic
graphical element, it would be necessary to first place a Smart 3D nozzle on top of the CADWorx nozzle
before being able to route from the nozzle, which would result in additional components being introduced
that are not actually needed in the real world.
The system remains in routing mode and dynamic routing is constrained to the North plane.
The length of pipe is also locked at 350mm.

Length:

350.00
Click the padlock icon El_ to unlock the length so that as the cursor moves it is varies again.

Continue routing...

Ensuring you see the N glyph, click once with the LHB again somewhere in the area highlighted below

Right click anywhere to terminate pipe routing mode.

After a few seconds, Smart 3D will identify that a clash exists between the CADWorx model and the
Smart 3D pipe, and will highlight it as shown below
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Note. Unfortunately there’s insufficient time during this workshop to go any deeper into pipe routing in
Smart 3D.

Don’t worry about fixing the clash; just continue with the final task...
Generating a piping isometric

Next you'll use ISOGEN to create a piping isometric for your pipeline.

Select

|Too|s Project SmartPlant T
' Select by Filter...
Shicy
Hide
Shaw all

PinPoirt

SmartSketch Options
Add to SmartSketch List
Get Point

Point Along

Measure

Check Interference

Run Report...

Drawing Console...

Snapshot View 3

Custom Commands...
Utilities »
Options. ..

Check Manufacturability
Weight CG

This dialogue will appear

:f Drawing Console

SP3DTrain
{1 Drawings
& lsometrics
{:I Reports
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Expand the Isometrics tree

(L] Drawin

_ig lso
_ip lso

gs

E| [ lsometrics
i Iso Pipeline lsometrics

Spoal Isometrics
WES lsometrics

@ |sometrics with Option Ovemide

{_] Packages
#-{Z3 Repors

Expand the Iso Pipeline Isometrics tree then select any children at the top level and delete them by right
clicking on the entry and choosing delete from the pop-up menu. Repeat until the Iso Pipeline Isometrics
folder is empty as shown

" Drawing Console

| SPDTrain
D Drawings
=] Isometrics

i lso
: i lso

i _iy Iso Pipeline |sometrics

Spool Isometrics
WBS lsometrics

[;':l lsometrics with Option Ovemide
#-{_1 Packages
-] Reports

Right click on Iso Pipeline Isometrics and select Setup

EID lsometrics
_@ s RunQuery
g :5 Cut
E@B o,
R
(1 Repol  Delete
Rename
Save Package...
Properties

Pick More... from the drop-down

— Filter:

v m

L
. Vore..

— Package:

IW lza Pipeline

0K I Cancel |
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Pick All from the Select Filter dialogue then click OK

x|
Dl @9 x| ek

[ Catalog Filters -
[_ Defautt Fiters

[_]1 Rule Fiters

(1 Plant Fiters

—=¢ All Systems

= All with Reference 3D

=7 CADWonc

e i | Composed Drawing Fiters
= CW

— % cw pipes

B0 Drawings Creation Filters
-I1_1 For Instructors Cirby
- Isometric Drawing Filters
(1 New Folder

B[] Structure Fiters e
i | Training Fitters

(20 My Fiters

[~ CrowoRx [
ok |  cancel |

Click OK to close the Setup dialogue

setwp
— Fitter:
[% |
—Package:
IW lso Pipeline j

e |

Right click and select Run Query
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Drawing Console

| 5P2DTrain
{:| Drawings
E-{] Isometrics
Run Query
i lso Spoc '
id lso WBE  cut
(i3 lsometic  Copy
: -] Package
M-{Z3 Reports Delete
Rename
Save Package...
Setup...
Properties

Please be patient whilst Drawing Console executes the query and populates the tree

Drawing Console x|

el SP30Train

=20 Drawings
L——_ID lsometrics
E_@ lso Pipeline |sometrics
e .] Al

Right click on Iso Pipeline and select Create Drawing(s)

=G U3
i E@ CADWon_Fipelines

Right click and select Update Now

L am o
EI@ CADWon_Pipelines
lza Pipeline
-4 T-101 Edit
G- Water Option Override. ..
[]..m o4 Refresh
- U0s
e ik LS el
) U0 Update Now
vl !

Drawing Console will have minimized itself to the Task bar, click to reinstate

‘ 53D _Train_A2_Reference_3D.ses : Piping : SP30Train : S3D_Train_A2_Reference_3D - [GraphicVi. ..

== Drawing Console
Dset| 2 B - &Gl

Right click on the drawing, which should include a green tick symbol, and pick Edit
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Elﬁ CADWone_Pipelines
: EI lzo Pipeline

5@ 0 ‘

@ Water Option Qverride. ..
T i Dafrack

Double click on the SmartSketch banner to maximize the main window then click =] to fit the drawing

= SmartSketch Drawing Editor - [Iso_Pipeline-2-OH-5001-150-1H2{00033457-0000-0000-4201-3610; oy [ 1]
[ Fle Edit view Insert Format Tools Window Help — 81|

EELE R e e L EL L AR e
| 5 SR E =[O = o )= 5 |

— m
3

e

5

ER

~

@

D-

& o
+

i,

<

A

=

H
_ [FIATEI, Sheet1 Ti<d | B
For Help, press F1 [x=193 1/2mm ¥=3329/15 mm [ num | v

Use the Zoom tool e to zoom in to the highlighted area

=]

EL +12‘1.11#1£“\/\

HQO SEQOL FOUND

COHN IO

W4

2 imn RFFE 150
W o2l1"1.1/1€"

H 77'"7_.7/16"
EL +#12"23.5/1€"™

Lfdn

L.

(]

Notice the connection to nozzle N4 on equipment E-101.
Unfortunately this is all we have time for during this workshop.

Don't forget to read the additional information found in Appendix | at the back of this document.
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Complementary workshop

Complementary workshop

Feel free to attend this complementary session to be held in room #304/5 @ 15.30pm on Wed 4 June.

Session Detail

Session ID

Session Title
Abstract

Track

Sub-Track

Focus Area
Discipline

Length

Audience Type
Employee Speaker

Day and Time

2155

Using SmartPlant Interop Publisher Smart Models in Intergraph Smart 3D

SmartPlant Interop Publisher (SPIOP) can be used for managing, positicning, and
translation of Smart Models generated from variocus sources such as Smart 30, PDMS,
FDS, CADWorx, and other systems. This allows common mapping and data processing
in SPIOP to reference the models into Smart 30 using SmartPlant Reference Data, and
therefore the source-specific mapping can be eliminated. This hands-on workshop will
explain the workflows and benefits of using SPIOP to reference 30 data into Smart 30

Process, Power & Marine
Project Execution
Design

Fiping & Mechanical

45 Minutes

User

Robert Stuchlik
Senior Support Consultant

Wed4 June 15:30
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Appendix I: Translating 3D models with SmartPlant
Interop Publisher

The SmartPlant® Interop Publisher (Publisher, SPIOP) provides a single solution to handle various 3D
model and data formats (graphics and object properties) for display and use in Intergraph SmartPlant
Review, Smart 3D, SmartPlant Foundation, and SmartPlant Construction applications. (Note: an
additional add-on module is required to publish to SmartPlant Foundation and SmartPlant Construction.)

Built upon proven technology, Publisher will simplify your project configuration by offering quick and
effective integration of multiple 3D models from sources like PDS, PDMS, PlantSpace, MicroStation,
AutoCAD, CADWorx, Caesar Il, SAT, IFC, XMLPIlant, i-model or even multiple Smart 3D sources. Source
model graphics and object property files are mapped into a common graphic and data format. Consult the
Intergraph web pages or product documentation for a complete list of supported source model formats.

Typical users include project managers, administrators, engineering leads, who need to prepare various
3D formats for use in the project. Add the source files to the project and translate the files, which results
in the Smart Model that can be used with the Intergraph applications. If needed, you may optionally
transform the resulting Smart Model (moving, rotating and/or scaling the model), or you can perform this
step later in SmartPlant Review or SmartPlant 3D application themselves. You can then provide the
Smart Model to joint venture partners for their use.

In Smart 3D, you attach the Smart Model as a reference to the Smart 3D project to view it and model
against it. You can:
B Attach multiple Smart Models (reference files) from different sources to your Smart 3D model.
B Inspect and provide property views for the referenced model objects.
B Filter objects from referenced models based on their type and properties.
B Extract drawings using graphic and label rules, showing relative positioning of objects from
referenced models with limited annotation.
In SmartPlant Review, you can open and combine Smart Models for design reviews. You can:

B Walk through the 3D Smart Models to understand the design or construction status during a
design review

B Perform clash detection against objects in the Smart Models

m Perform motion collision detection by moving Smart Model objects along a path
In SmartPlant Foundation, you can register the Smart Models with the corresponding plant (Note: an add-
on module is required to publish to SmartPlant Foundation and SmartPlant Construction.)

B Publish the 3D model graphic and object property data using the delivered mapping and data
formats, delivered OOTB with Publisher

B If needed, custom properties that you wish to include in the translated model, you must map them
using the Schema Editor in SPF

B In SmartPlant Foundation, query and view the 3D model along with associated links to other non-
graphic data stored for with plant in SPF

B Using SmartPlant Construction retrieve components from the resulting Smart Model to create
construction work packages
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You can use data from different sources such as PDS, PDMS, Tekla, AutoCAD, or Microstation files, and
use the resulting model in Intergraph applications. SmartPlant Interop Publisher supports generic industry
standards, such as Building Information Management (BIM), including Industry Foundation Classes (IFC),
CIS/2, and others.

SmartPlant Interop Publisher provides solutions for business cases such as the following:

B Provides the ability to work with a wide range of datasets from Intergraph and non-Intergraph
formats such as PDMS and XMpLant

B Model data in other formats such as PDMS and XMpLant can be translated to the format
recognized by SmartPlant Enterprise applications. This allows for heterogeneous tools to be used
on a single project.

Supports disconnected workshare

Because the data is translated to files at the source site and attached as a reference at the target
site, live connection between the databases is not required. Periodic publish and update of the
Smart Models allows multiple partners to work on a joint venture project.

Allows for better security in joint venture projects

Network connectivity is not required. The translated files can be transferred using any appropriate
mechanism.

Allows you to protect your intellectual property

Share only what you want your partners or subcontractors to see by filtering specific sections of
the plant or object properties you want to include or exclude from model data that is shared.

Supports parallel design for increased productivity

If a project has several similar units, only one unit has to be modeled and translated. This
translated unit can then be attached multiple times with the required positioning.

B Allows for better use of survey data from laser scanning for construction and as-built projects

The converted 3D model can be viewed when displaying laser data in the SmartPlant Enterprise
applications.

MicroStation SELECTseries3 08.11.16.357 or later is used to access the RealDWG library, which will
then use the CADWorx Object Enablers to translate the CADWorx proxy objects to give a true
representation of the graphics in Smart 3D.

Natively, SPIOP uses the OpenDWG Library to translate AutoCAD documents. By default, this handles a
standard AutoCAD file pretty well. However, AutoCAD documents can have “proxy” objects created by
3rd party vendors (MicroStation, CADWorx, etc.). In order to view those proxy objects in AutoCAD (not
just the line-representation) you must use an “Object Enabler” to see the actual proxy object and not a
stand-in object.

The OpenDWG library that Intergraph uses cannot load object enablers. This means natively, we can't
see proxy objects inside an AutoCAD file.

MicroStation uses the RealDWG library to translate AutoCAD documents. RealDwg can use object
enablers to view/translate proxy objects.
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SPIOP will first check for MicroStation, and if it is installed, use it to translate all AutoCAD documents. If
not, it will roll back to its internal OpenDWG library. If it uses MicroStation, then it uses the (CADWorx)
Object Enablers as well to translate any AutoCAD files and their proxy objects. Otherwise, it will use the
internal library and will not translate the proxy objects.

SmartPlant Interop Publisher enables you to work with file types from a variety of data sources as shown
in the tables below. To further expand our data source coverage, SmartPlant Interop Publisher supports
several generic formats, which can allow other systems or companies using these formats to also be
supported.

In terms of Intergraph software, the following are supported:-
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Company Application Graphic Data File SmartPlant Interop Notes
File Publisher License
Intergraph (SPE) Smart 3D v2009.1 ZVF XML No A license of SmartPlant Interop
and above in an Publisher is not needed to reference
integrated this format in S3D
environment
Smart 3D v2009.1 VUE XML No A license of SmartPlant Interop
and above in a non- Publisher is not needed to reference
integrated this format in S3D

environment

Smart 3D Pre VUE XML No A license of SmartPlant Interop
v2009.1 Publisher is not needed to reference
this format in S3D

Smart 3D using VUE MDB2 Yes
SmartPlant Review
Direct

PDS, FrameWorks® | DRI, DGN | DRV, TAG Yes
Plus

ISOGEN® (IDF,PCF, | IDF, PCF, | IDF, PCF | Yes
POD) POD

1 Requires Bentley MicroStation SELECTseries3 (08.11.09.357 or later) to be installed on the workstation used to handle CADWorx proxy objects via SmartPlant Interop Publisher.
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Basic Workflow diagram

Intergraph Proprietary Information

Supporied 30 eaflwars

SmarlPlant inarop Fudlisnor

- T - 0 o -y . -
o |lotional] Register | | Define _ |Trarslste source| | (oobonal) 2] i e
| SPIOF projectto [P configuraton [B{ AL0CR 1S 18 Ty Smort [P Trarsform Smart | Pistibute Smart) R Pulieh Smm
SPFplent | | setings i Profetl | el | wode il Ve
- v T F e -
SrrasrtFlani Review
- 5
—= Open Smart
W oded
1 e ——
Srar 30
_ 0
N | Aach Smar |
| ™| Mode! to Smart
A0 moded .
Schema Edifor

SmartPlant Foundation

4

Review Smart
hicdl

SmartPlani Constnection

15
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If you have any questions or queries, please feel free to contact me

Paul Martin

Technical Manager

Intergraph CADWorx & Analysis Europe

D: +44 (0)1925 811552 M: +44 (0)7977 256928
E: paul.martin@intergraph.com

Intergraph (UK) Ltd
2" Floor, Gleneagles House, Vernon Gate,
Derby, DE1 1UP. UK.

intergraph.com | LinkedIn | Facebook | Twitter
Intergraph is part of HEXAGON
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